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QI Project Graphing

For the majority of users, it is much easier to understand data, especially numerical data, through
pictures rather than tables. “A picture is worth a thousand words” is a well-known adage that applies as
easily to performance data as it does to the world in general. Taking this adage one step further in terms
of “performance data”, we should add “but only if it is the RIGHT picture”.

How do | Access Graphing?

Click on the Graphing link which is found on the “Reports/Graphs” menu from the main product tabs.

CMC Main Menu

Data Entry: Utilities:
- Enter Case Data » Create CSV Export File
» Add a Case » CSV Codebooks

» Find a Case » Download CSV Export File

» ICD9 Population Recount

Reports/Graphs: - Sample Data
. Data Management - QNet Transmission Page
Reports » Custom Fields Admin

» Rate Report
« Reference Group Analysis

» Quarterly Report
= Graphing S
« ORYX Center

Outpatient Main Menu

Data Entry: Utilities:

» Enter Case Data » Create CSV Export File

» Add a Case » CSV Codebook

. Find a Case » Download CSW Export File
» ICD9 Population Recount

Reports/Graphs: » Sample Data

. Data Management Reports - Custom Fields Admin

. Rate Report » QNet Transmission Page

» Reference Group Analysis
» Quarterly Report
1) —

enter

v
. ORY

Psych Insights Main Menu

Patient Level Measures
(HBIPS)

Data Entry:

. Enter Case Data
« Add 3 Case

. Find a Case

Reports/Analytics:
» Data Management Reports
. Rate Report
» Refarence Group Analysis
]
) —
. Generate quarterly report
» ORYX Center

Aggregate Measures

Data Entry:
» Enter Data
« Select Measures

Data Tools:

. Audit data

« Browse data

» Create data collection
worksheets

» Export aggregate data

« Export facility data

The steps in this guide provide an orientation to the chart types and how to create them. Refer to the Data
Analysis Guide and on-demand webinar sessions for details on interpreting graphs. Graphing is also
supported by in-product HELP that provides guidance and explanations of graphing elements, charts and

tables.
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QI Project Psych Insights

Each graphing * Data Entry : aphing Questions He Mindows Internet Explore

element has its own —
help link {a blue Wi
question mark in

- |§, http: fivbp.giproject. org/graphinghelp/Purpose_OF _Chart.htm A |

parentheses). This is Choose a chart type:(?) | Contral Chjl gle| v | 29 search ~ <« [H - ca- st
the same convention M Sat:

easure Set: | HBIPS v | |search| | 2 B &= Mal v & amExpre:
we use for data i AlM
element HELP on the Measure: | [Select A | S snaae B B

data entry screens.  [What is the purpose of your char‘t —

® Perfor g ﬁ'ﬁ? [@Graphing Questions Help l
Clicking the link will

bri brief (O Statistig i - -
ring up a arie Graphing Questions: What is the purpose of your chart?
context-specific

explanation for that
item, element or
option.

There are two principal reasons for generating control charts: performance img

iGo To Graphing User Guide™=

Performance improvement: Control charts plotted for performance improvem:
identify outliers, trends and shifts in process. See "Control Charts".

What Graphs are Available?

The three types of charts available in the QI Project® graphing function are control charts, comparison
charts, and other graphs (a simple line chart). Each chart is always accompanied by a table of values that
summarizes the values on which the chart was based. All charts and tables created in the graphing
feature are created using SAS, one of the most sophisticated and powerful statistical programs currently
available. The charts and tables created can be saved but cannot be modified in any way. For example,
you cannot change font size, colors or marker types. The default chart for performance improvement is
always the Control Chart.

Common graphing elements display default values that are pre-programmed. For example, the default
start month and year is always the earliest month and year that data were collected by your facility for a
measure. The default end month and year is always the current month and year.

To make the most efficient use of your time, each graphing selection you make when creating a chart is
“sticky”. This means that you do not have to re-select each element or re-enter date values if you decide
to create the same chart type for more than one measure or if you decide to create a different chart type
for the same period.

/’Clear All Selections

Choose a chart type:(?) . .
type:(?) | g You can restore the default settings for all selection

Measure Set: E elements by clicking on Clear All Selections in the

Measure: m upper right corner. -
What is the purpose of your chart? (7)

& Performance Improvement (?)

) statistical Unifarmity (?)

© 2011 Press Ganey Associates, Inc. 2
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The default chart choice is always the control chart since this chart best displays your facility’s process of
care, the processes’ control limits and relevant types of special cause variation. A control chart is
particularly useful in identifying special cause variation in your facility’s data. Special cause variation
occurs when something external to your process influences performance for that process of care. Special
cause variation must always be identified and eliminated from processes to insure the best possible
outcomes.

SAS will identify three common types of special cause variation and automatically flag them in the graphs
and accompanying tables. Refer to the table below for the four types of Statistical Process Control (SPC)
tests identified.

Identifying Special Cause Variation

SPC Test ||Special Cause Type ||Description of Special Cause
Test 1 IIOutIier ||Any data point beyond the identified sigma limits
e Nine or more consecutive data points on the same side of
Test 2 hift in the pr .
est Shift in the process the Centerline (CL)
Test 3 Trend Six or more consecutive data points whose values steadily
increase or decrease

Data oscillations (Zig-Zag or

Test 4
est saw-tooth)

14 or more points in a row alternating up or down

SAS automatically creates the correct control chart for a measure’s data type. The two data types are
discrete data (found in CMC, OPC and Psych Insights) and continuous data (found only in CMC and
OPC).

= Discrete data (which are things we count)
SAS creates
— p-chart for proportion measures
— u-chart for ratio measures
= Continuous data (which are things we measure),
SAS always creates an I-chart which is the preferred analysis tool for these measures.
— Depending on the number of data values for the period in your graph, in addition to
the I-chart, SAS may also permit you to create an aggregate chart.
An X-bar and s chart, that averages the individual values for each month
and then plots the monthly average in the topmost of two charts and each
month’s standard deviation value on the lower chart, or
An M-chart that plots the median value for each month in the topmost of two
charts and the range for each month on the lower chart.

A word of warning is in order about data aggregation. Aggregating data can actually hide special cause
variation and lull you into a false sense that all is well with your process. Aggregation should always be
approached with caution and individual values must always be analyzed first before any aggregation is
attempted.
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Comparison Charts

The second chart type available to you from the drop-down list on the graphing link is a Comparison
Chart. A comparison chart is a special chart that compares your facility’s monthly performance values for
a measure to the aggregate performance of all other QI Project facilities for the same measure.

The QI Project® creates two types of comparison charts, each tailored to the type of data type collected
by the measure. Factors that influence the comparison chart type are whether the data are discrete or
continuous, and, if discrete data, whether the measures are proportions or ratios. Because health care
data are not normally distributed and population sizes for a measure may be small, further adjustments
are made to the calculations for the expected performance interval using the values for the QI Project-
wide comparison group's weighted mean rate, the facility's rate, and the facility’s population.

SAS automatically creates the correct comparison chart for the measure’s data type.

= Discrete data (or things that we count)
=  The comparison chart calculations generally produce upper and lower limits of the
expected performance interval of unequal size. When the facility rate is less than 50, the
lower interval will be larger than the upper interval. Conversely, when the facility's rate is
greater than 50, the upper interval will be larger than the lower interval. Should the facility
rate be exactly 50, the upper and lower range intervals will be of equal size.

= Continuous data (or things that we measure)
= There is no adjustment for the facility’s rate or population and the upper and lower parts
of the range interval will always be equal.

The QI Project recommends that you view the entire chart carefully with an eye to examining your
facility's overall performance within the context of other QI Project facilities. Placing your facility's overall
rates in context with the comparison group's weighted mean can help you decide whether to celebrate a
success or strategize on ways to improve performance.

Other Graphs

The third chart available to you from the drop-down list on the graphing link is other graphs. This is a
simple line chart that allows you to plot specific values: your facility’s values, the Ql Project-wide values
or, if appropriate to your facility, the Sponsor values. These values can be displayed singly or in any
combination with one another.

© 2011 Press Ganey Associates, Inc. 4
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Creating Graphs: Control Charts

Discrete Data: the p-chart and u-chart

As noted above, there are two control chart types used for discrete data; the p-chart, which is used for
proportions and the u-chart which is used for ratios. The following help text focuses on the p-chart as all
CMC, OPC, and Psych Insights discrete measures are proportions with the exception of HBIPS-2
(Restraints) and HBIPS-3 (Seclusion) which are ratios. Note that the graphing elements and options for
the u-chart are the same as those for a p-chart.

1. The chart type automatically defaults to Control Chart.

Clear All Selections
Choose a chart type:(?)( Control Chart v E]

. Measure Set\ HEIPS
2
Measure,) HBIPS-1a: Screening-Overall Rate v

2. The first two graphing elements after selecting Control Chart—Measure Set and Measure—allow
you to select the Measure Set and Measure for your control chart. Choose the Measure Set, then
the Measure you would like to chart. Note that for Outpatient measures graphing, you actually
choose a Topic (Emergency Department or Surgery) and then the Measure.

3. The next selection element is, “What is the purpose of your chart?” Select the response option
based on what you intend to examine when looking at your chart.

(What is the purpose of your chart?

(® Perfarmance Improvement (?)

(O Statistical Uniformity (?)

Your response to this question determines which special cause variation rules SAS will apply to
the control chart.

= |f you choose performance improvement (the most common reason for creating
a control chart), SAS will apply all applicable special cause variation rules as it
automatically analyzes the chart.

= |f you choose statistical uniformity, SAS applies only the outlier rule since your
purpose is to check whether the data values for the period graphed are statistically
uniform; or more simply, whether outlier or extreme values are present. If outlier
values are present, the data are not statistically uniform.

4. How would you like to plot your data? This graphing element gives you two options based
again on the data type.
= For p-charts used for discrete data found in proportion measures, you can choose to
graph either on a Monthly basis (recommended) or on a Quarterly basis. For quality

© 2011 Press Ganey Associates, Inc. 5



> .
ver PRESS GANEY

Outcomes driven. Performance strong.

activities, it is always best to graph monthly rather than aggregate the data by quarter
because quarterly graphing “flattens” the data. Aggregating data can actually hide
special cause variation and lull you into a false impression that all is well with your
processes of care when quite the opposite might be true. Remember that
aggregating data moves your analysis further from actual patient experience.

@.‘ would you like to plot your data (monthly is recommended)? (?)
a

& Monthly
O Quarterly

CWhat is the date range you would like to chart? (?)

(Date range is based on discharge date)
Enter start month, year: [ October v || 2008 v

Enter end month, year: | December v” 2010 v|

5. Next you'll choose the Date Range you wish to plot in the control chart. For Monthly aggregate,
you choose the Month & Year to start the graph and end the graph. For Quarterly aggregate, you
choose the Quarter & Year to start the graph and end the graph. Any interval of months, quarters
or years can be graphed.

6. After making all necessary selections to create your control chart,
click on the Generate Graph button at the bottom of the selection q Generate Graph ]

page.

Format and Layout: p-chart and u-chart

The data table of values appears below the chart. The format and layout of the data table for the u-chart
mirrors that of the p-chart. Click on the help links (?) to bring up the files that explain the specific
calculations and variables included in the chart and table.

© 2011 Press Ganey Associates, Inc. 6



> .
v PRESS GANEY

Outcomes driven. Performance strong.

Click on Save Graph to save the

The light blue

charts sigma
control limits.

highlighted area
demarcates the |<

Click on Save
Table to save
the table to a

csv file
N

Continuous

P Chart(?) graph to an image file.
Save Graph
P Chart for Performance Improvement
HBIPS-1a: Screening-Overall Rate
3o Limits
1.00
UCL
0.95
0.90 —
@ P=.291
&
e .
- The facility's process of care is plotted as a
T 0854 blue line with each month's performance value
L - - -
G indicated by a dot on the line.
0.75 4 Red dots indicate that special cause variation
’ was identified. See the SPC Test column of the
data table to see which test(s) were identified.
0.70 ~
—————
20080¢ct 2009Jan 2009Apr 2009Jul 20090ct 2010Jan 2010Apr
Date
Subgroup Sizes Minn=106 Maxn=131
P Chart Subgroup Size Table(?)
Save Table
|_Date | Hum [Den | p value | SPC Test Subgmup Small # mml"
20080CT 101 129 0.7829 1 0.809  0.8913
2008M0V 102 124 0.8226 M Y 0.8074 0.8913
2008DEC 92 123 0.748 o M Y 0.8071 0.8913 [

Data: the I-chart, X-bar and s chart and M-chart

For continuous data measures an I-chart is always produced. Depending on your data set, SAS may also
allow you to create an X bar and s chart or an M-chart. The following help text focuses on the I-chart as it
is always created for continuous measures.

1. The chart type automatically defaults to Control Chart.

© 2011 Press Ganey
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2.

5.

© 2011 Press Ganey Associates, Inc.

The first two graphing elements after selecting Control Chart—Measure Set and Measure—allow
you to select the Measure Set and Measure for your control chart. Choose the Measure Set, then
the Measure you would like to chart. Note that for Outpatient measures graphing, you actually
choose a Topic (Emergency Department or Surgery) and then the Measure.

(What is the purpose of your chart? (7]

& Performance Improvement (?)

(O statistical Unifarmity (?)

The next selection element is, “What is the purpose of your chart?” Select the response option
based on what you intend to examine when looking at your chart.

Your response to this question determines which special cause variation rules SAS will apply to
the control chart.

= If you choose performance improvement, SAS will apply all applicable special cause
variation rules as it automatically analyzes the chart.

= |f you choose statistical uniformity, SAS applies only the outlier rule since your purpose is
to check whether the data values for the period that is graphed are statistically uniform, or
more simply, whether outlier or extreme values are present. If outlier values are present, the
data are not statistically uniform.

The next selection element is, “What type of data would you like to chart?” Select the
response option based on what you intend to examine when looking at your chart.

@at type of data would you like to chart? (E

® Individual
(O Aggregate

The options provide the capability to plot either Individual values (the preferred approach) or to
plot Aggregate values (always approached with caution).

= Individual is the default choice because you analyze each case to evaluate the time it took
from arrival to that measure’s clinical intervention. Choosing the default creates an I-chart;
where the “I” stands for “individual values”.

= Choosing the Aggregate option may produce an X bar and s chart or an M-chart in addition
to the I-chart if the data set for the period graphed must meet specific population criteria for
aggregate charting. Should the data set not meet these criteria, SAS will produce only an I-
chart.

a. - If you select Individual values for the question, “What is the purpose of your chart?”
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@at type of data would you like to chart? (E

® Individual
Ohggregated
(nter start date: |g5/05/2010 :ﬁ_\\
Sa
Enter end date: |10/29/2040 :ﬁjj

Define the time period for an I-chart by selecting the Date Range you wish to plotted in the
control chart. Choose the Month, Day and Year to start the control chart and the Month, Day
and Year to end the control chart. Any period of time for which you have data can be
graphed.

5. b. - If you select Aggregate for the question, “What is the purpose of your chart?”
1. An additional graphing element will appear, “How would you like to plot your data?”

@at type of data would you like to chart? dﬂ

O Individual
© Aggregate —,
@.’ wiould you like to plot your data (monthly is recommended)? (7) ‘ 5b1
@ Monthly
O quarterly

= Choose to graph either on a Monthly basis (recommended) or on a Quarterly basis.
For quality activities, it is always best to graph monthly because quarterly graphing
“flattens” the data. Aggregating data can actually hide special cause variation and lull
you into a false impression that all is well with your processes of care when quite the
opposite might be true. Remember that aggregating data moves your analysis further
from actual patient experience.

2. Define the time period for the aggregate chart by selecting the Date Range you wish to
plot in the control chart. For Monthly aggregate, you choose the Month & Year to start the
control chart and the Month & Year to end the control chart. For Quarterly aggregate, you
choose the Quarter & Year to begin the control chart and the Quarter & Year to end the
control chart. Any interval of months, quarters or years can be graphed.

(What is the date range you would like to chart? (?) ) 5h2
Enter start menth, year: | January |+ || 2006 v

Enter end month, year: | December || 2010 +

= |f the data set for the period you wish to graph meets population requirements, either
an X-bar and s chart or an M-chart may be created. Should the data not meet
aggregation criteria, SAS produces only the I-chart.

6. After making all necessary selections to create your control chart, q Generate Graph ]E]
click on the Generate Graph button at the bottom of the selection

page.

© 2011 Press Ganey Associates, Inc. 9
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Format and Layout: I-chart

A data table containing the values on which the chart(s) were based appears below the I-chart, X-bar and
s chart or M-chart. Unlike the control charts for discrete data, a control chart for continuous data has two
individual chart components. The upper chart plots each individual value for the period graphed. The
lower chart plots the Moving Range. Clicking the help links (?) will bring up Help text that explains
calculations and variables included in the chart and table.

E IChart(?) Click on Save Graph to save the
rd - .
Save Graph graph to an image file.
| Chart for Performance Improvement
PN-5: Atbx Timing (Median)
1 350 Limits
1500 | | Red dots indicate that special cause For“n:2
variation was identified. See the 5PC Test
12509 | column to see which test{s) were identified.
S 1000 -
E The facility's process of care is
% 750 plotted as a blue line with each UCL=676.6
@ value indicated by a dot on the line. o
2 5004
¥=206.1 The light blue
~ highlighted area
LCL=0 demarcates the
charts sigma
. control limits.
[=21
[ =
m
x
g
= UCL=552.8
[=]
=
R=181.7
T T T T T T T T T T LCL=D
Click on Save 0 10 20 30 40 5 | 80 70 80 90
Table to save
the table to a Case Order
csv file
\ E I Chart Subgroup Table(?)
Save Table
05/20/2010 12 12110197 250 110 73.5 0 206.1011 676.6222 0 151.6932 34
05/20/2010 13 12129710 80 172 73.5 0 206.1011 676.6222 0 151.6932 5!
05/21/2010 14 12109903 914 ag2 1 73.5 0 206.1011 676.6222 0 151.6932 5!
05/21/2010 15 12129914 a1 874 73.5 0 206.1011 676.6222 0 151.6932 5
Core measures performance data Probability Plot for Performance Improvement
are skewed. Although Statistical PN-5: Atbx Timing (Median)
Process Control inherently adjusts 999

for some degree of skewing,
extreme skewing can adversely
affect even Statistical Process 90 -

99

Control analysis; specifically the % 75 1
ability to accurately identify a true E 50+
outlier. A special graph—the T
probability plot—has been S

developed to visually help you 5 -
determine the degree of skewing

— Normal Parameters

_ : 11 W Mean (Mu) 206.1071
present in continuous data. Std Dev (Sigma)  182.9357
01 L T T T T T T T
0 250 500 750 1000 1250 1500
Measurement

© 2011 Press Ganey Associates, Inc. 10
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The Y or vertical axis of the probability plot has been created to perfectly mimic a bell-shaped curve. The
data points in a data set that is normally distributed (data without any skewing whatsoever) will line up as
a straight line on a probability plot. Data that are skewed produce a distorted line—the more distorted the
line, the greater the degree of skewing. A simple test has been developed to screen a probability plot for
extreme skewing—the “Fat Pen Test”. If you can cover the majority of data points on a printed probability
plot with a typically sized ball point pen, the data are not extremely skewed and subsequently pass the
Fat Pen Test. If you cannot cover the majority of the data points, the data set fails the Fat Pen Test and
extreme skewing is present. Minor skewing does not significantly affect your ability to identify outliers.
Extreme skewing affects the ability to determine which, if any, data points in a distribution might actually
be an outlier or extreme value. Click on the help link (?) to bring up the files that explain how to examine
the probability plot.

Format and Layout: X-bar and s chart

As was the case for previous control charts, there is a table of values and associated help files that
explain the variables on which charts and associated table are based. An X-bar and s chart is a paired
control chart that plots subgroup averages and the standard deviation of the subgroups. The X-bar graph
appears above the s graph.

B Xbar and S Chart(?) 4| Click on Save Graph to save the
Save Graph graph to an image file.
Xbar and S Chart for Performance Improvement
AMI-8: Median Time to Primary PCI
2.5¢0 Limits
4004
The facility's mean for each ucL
300 subgroup is plotted as a blue line
with each value indicated by a dot
= 2004 on the line.
@ F=146.8
= oo
04 The blue
See the SPC Test column to see which Lol highlighted area
1004 test identified the special cause demarcates the
variation indicated by a red dot. charts sigma
500 + control limits.
4004
3 300
2 200 ucL
n
100 5
0 —" LcL
. EUUQJan EUUQMar EUUQMaY 2 UQJUI 200989p QUUQNDV 20 UJan 2010Mar 2010May
Click on Save
Table to save Date
the tabla to a Subgroup Sizes Minn=2 Maxn=5
csv file
\ D Xbar and S Subgroup Table(?
Save Table
| _pate JDen] x| s | mmmmmm 2
2009FEB 2 130 36.7696 0 146.7619 339.5904 0 87.0334
2009MAR. 2 161.5 79.9031 0 146.7619  339.5004 0 87.0334 25
2009MAY 2 97.5 41.7193 a 146.7619  339.5904 a 87.0334 25
20093un 3 398.3333  412.3493 ] 146.7619  304.2057 ] 06.6099 22,

Note that gaps result when there is an absence of data for a particular month. This is not to be confused
with a Phased control chart.

© 2011 Press Ganey Associates, Inc. 11
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Format and Layout: M-chart

As was the case for previous control charts, there is a table of values and associated help files that
explain the variables on which charts and associated table are based. The upper or M-chart plots the
median of all values for each month while the lower R chart plots the range values for each month.

l:‘ M and R Chart(?) &~ | Click Save Graph to save the
Save Graph | graph to an image file.
M and R Chart for Performance Improvement
AMI-8: Median Time to Primary PCI
2.5g Limits
4004
o = . ucL
200 4 The facility's median of medians for each
subgroup is plotted as a blue line with
& 2004 each value indicated by a dot on the line.
= _
@ M=136.8
= 100
04 The blue
LcL highlighted area
-1004 demarcates the
1000 4 charts S|.gn.wa
control limits.
7504
L]
[=2]
S 5004
o« ucL
250 -
R
0 LCL
T T T T T T T T T T T T T T T T T
2009Jan 2009Mar 2008May 2009Jul 20095ep 2009Mov 2010Jan 2010Mar 2010May
CII;T Save Date
Table to save Subgroup Sizes Minn=2 Maxn=458
the table to a
csv file, l:‘ ) See the Test column in the table to see which test identified
\ M and R Subgroup Table(?) special cause variation indicated by a red dot on the line.
Save Table
| Date _[n=]| ™M | R | [ tcim | meanm | vom | 1R | Meanr | uds
2009FEB 2 130 52 1] 136.8005 331.7268 0 124.4172 359,
2009MAR, 2 161.5 113 0 136.8095 331.7268 ] 124.4172 359,

© 2011 Press Ganey Associates, Inc.
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Creating Graphs: Comparison Charts

1.

Choose Comparison Chart from the “Choose a chart type” graphing element drop-down list.

Chaose a chart type:({) | Comparison Chart | |1
Measure Set: \HF v|

MEBSW_‘%HFJ Disch Instructions V|

The first two graphing elements after selecting Comparison Chart - Measure Set and Measure -
allow you to select the Measure Set and Measure for your comparison chart. Choose the
Measure Set, then the Measure you would like to chart. Note that for Outpatient measures
graphing, you actually choose a Topic (Emergency Department or Surgery) and then the
Measure.

How would you like to plot your data? is a graphing element that gives you two options.
= You can choose to either graph on a Monthly basis (recommended) or on a
Quarterly basis. For quality activities, it is always best to graph monthly rather than
aggregate the data by quarter because quarterly graphing “flattens” the data.
Remember that aggregating data moves your analysis further from actual patient

experience.

@w would you like to plot your data {monthly is recommended)? (?%
(& Monthly
O Quarterly

Cwhat is the date range you would like to chart? (?) 4
Enter start month, year: |Januaw v | | 3009 v|

Enter end month, year: | September v||2(]1|:| v|

You next choose the Date Range you wish to plot in the comparison chart. For Monthly
aggregate, choose the Month & Year to start the graph and end the graph. For Quarterly
aggregate, choose the Quarter & Year to start the graph and end the graph. Any interval of
months, quarters or years can be graphed.

Once you have made the desired selections to create your chart, click — E
on the Generate Graph button at the bottom of the selection page. ({__Generate Graph_ |

Format and Layout: Comparison Chart

The comparison charts provide a comparison of facility performance to QI Project-wide performance. The
data table of values appears below the chart. The format and layout for discrete and continuous
measures are the same. Click on the help links (?) to bring up the files that explain the specific
calculations and variables included in the chart and table.

© 2011 Press Ganey Associates, Inc. 13
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Comparison Chart(?)
= () Click on Save Graph to save the

Save Graph #————— . )
graph as an image file.

Comparison Chart
HF-1: Disch Instructions

O ———— B - -
) The bar and whiskers
Y demarcates the 99%
) ) Expected Performance
4 Range as calculated by
084 P The Joint Commission.
4 4 4 +
? . i 4 MNote that the 99%
z " 4 1 Expected Performance
s - - 1 — Range is not a true
0.8+ * 1 The facility's performance is confidence interval
4 1 indicated by the blue dots. because the formula
1 . takes into consideration
The QI Project-wide aggregate mean value for our famlllfy s s.ubgroup
X _ ) or population size and
074 aroportions or median value for continuous data
1 measures is indicated by the red triangle.
-

T T T T T T T T T T
Jan Mar May Jul Sep Moy Jan Mar May Jul Sep

2008 2010
Click on Period
Save Table (e Faciliy Rale_a Projact Rate with 99% CL
to save the
tahletoa
csv file. Comparison Chart Subgroup Table(?)
S Save Table
m—mm*
2009]AN 33 0.6564 0.8278 362 1 0.656
2009FEB 31 0.8328 0.8462 357 1 0.7495 Y

Creating Graphs: Other Graphs

Other graphs are simple line charts that plot any combination of three values, (1) the facility rate, (2) the
QI Project-wide aggregate rate, and if appropriate to the facility, (3) the Sponsor mean rate.

1. Choose Other Graphs from the “Choose a chart type” graphing element drop-down list.
2. The first two graphing elements after selecting Other Graphs—Measure Set and Measure—
allow you to select the Measure Set and Measure for your chart. Choose the Measure Set, then

the Measure you would like to chart. Note that for Outpatient measures graphing, you actually
choose a Topic (Emergency Department or Surgery) and then the Measure.

Clear All Selections

Choose a chart type:(?(| Other Graphs v
Tﬂlm‘{Emergency.r Department V|
MEESUMOFM - Aspirin at Arrival - Overall Rate V|

3. How would you like to plot your data? This graphing element gives you two options.
= You can choose to either graph on a Monthly basis (recommended) or on a
Quarterly basis. For quality activities, it is always best to graph monthly rather than
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5.

aggregate the data by quarter because quarterly graphing “flattens” the data.
Remember that aggregating data moves your analysis further from actual patient
experience.

@, wiould you like te plot your data (monthly is recnmmended)?m
& Monthly
) Quarterly

CWhat is the date range you would like to chart? (?) 4
Enter start month, year: |JE|'|L|E|r}f v || 2008 v|

Enter end month, year: | Decemhber || 2010 v|

Choose the Date Range you wish to plot in the Line Graph. For Monthly aggregate, you choose
the Month & Year to start the graph and end the graph. For Quarterly aggregate, you choose the
Quarter & Year to start the graph and end the graph. Any interval of months, quarters or years
can be graphed.

Which data would you like to chart? provides three options available to chart with Other
Graphs. You may choose to plot one, two or all three of the options in any combination.
= Facility plots the facility values.
* QI Project-wide Comparison Data @ch data would you like to chart? [E
plots the QI Project-wide mean
values.

1 Bl
= Sponsor Comparison Data plots Facility
the mean values for all facilities [ Project-Wide Comparison Data

within the same sponsor group as
the facility. Not all facilities belong to
a Sponsor group.

[l Sponser Comparison Data

Once you have made the desired selections to create your chart, q Generate Graph ﬁ]
click on the Generate Graph button at the bottom of the
selection page.
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Format and Layout: Other Graphs

Line Chart lick h h h
Save Graph Clic S.ave Gra}p to save the grap
as an image file.
Line Chart
OP4 - Aspirin at Arrival - Overall Rate
1.0 A - [
w097
L
o
0.8+
T T T T T T T T T T T
Jan Mar May Jul Sep Mov Jan Mar May Jul Sep
2009 2010
Click Save Time Period
Table to save @ Facility Value m Sponsorvalue Project Value
the table to a
csv file.
Llne Chart Subgroup Table(?)
Save Table
Sponso Spﬂ Sponsor | Project Wide Poject W‘ide
Va Vahe Fadilities Value F i
20091AN 0.9802 9 0.9405 1478
2009FEB 1 5 0.8965 28 9 0.9409 1302 21!_

The data table of values appears below the chart. Click on the help link (?) to bring up the file that
explains the specific variables included in the chart and table.
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